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Achieving Reliable Print Output with Transparency:
Late Breaking News (9/29/2001)

On September 26, 2001 at Seybold San Francisco, Adobe announced and demonstrated Illustrator 10 and
InDesign 2.0. Both of these products provide significant improvements for reliable printing of transparency.
The document you are currently reading, however, was developed before these products were announced.
Some of the problems described here have in fact been addressed and corrected. In particular, most
problems related to interactions between transparency and overprinting and with linked documents have
been resolved. Adobe is currently working on a revision to this document that will include detailed
information on Illustrator 10 and InDesign 2.0. This revision should be available by the time these products
are released. In the meantime, below is a short synopsis of the improvements provided by each application.

Improvements in Illustrator 10

A number of significant changes were made to Illustrator 10 to provide customers preparing content for
output on high-quality printing presses. These changes are as follows:

•  The Raster/Vector slider (formerly known as the “Quality/Speed” slider) lets you choose a value from 0
to 100 (Illustrator 9 has only five settings).

•  The default setting for the Raster/Vector slider is set to 100 (Illustrator 9 used the middle setting, or 50,
as the default). This provides the highest possible quality results.

•  Overprinting is properly preserved in more cases (see chart).
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•  The flattener in Illustrator 10 respects object stacking order. This means opaque objects that overlap
transparent objects are not affected by flattening and that it is no longer necessary to always embed
linked documents that interact with transparent objects.

•  The optional Flattening Preview plug-in helps to identify and in some cases correct problems before
they occur.

•  Print performance has been greatly improved.

You can find more information on improvements made to Illustrator 10 for transparency (including how to
setup and use the new Flattening Preview plug-in) in the document “Adobe Illustrator 10 Flattening
Guide”, using this link: http://www.adobe.com/products/illustrator/pdfs/ai10_print.pdf

Improvements InDesign 2.0

Transparency is now fully supported by InDesign 2.0, which allows users both to create transparent design
elements directly in their layouts and to incorporate ‘live’ unflattened transparency from Illustrator and
Photoshop in the form of native files and PDF 1.4. InDesign 2.0 also provides the improved flattener
controls that Illustrator 10 implements plus the additional ability to define “flattener styles” which further
simply this critical workflow step.  Different styles can be applied to individual spreads for even finer
control. InDesign 2.0 also provides improved support for mixing overprinting and transparency and linked
files. You can find more complete information on transparency support in the InDesign 2.0User Guide.
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Achieving Reliable Print Output 

 

with Transparency

 

A practical troubleshooting guide for prepress service providers who work with the new 
transparency features of Adobe® software

 

What you will find here

 

This reference and troubleshooting guide gives you, a prepress service provider, the information you need to obtain 
consistent, high-quality output from files that contain objects created with the new transparency features in Adobe® 
software (specifically, Adobe Illustrator® 9.x). 

It explains how transparency is processed (“flattened”) when documents are exported or printed, and how flattening 
affects your workflow. It also tells you what controls Adobe applications give you over flattening.

This document may also be of interest to sophisticated production personnel and creative professionals who prepare 
content that contains transparency for high-end print output. This guide has three sections: 

Section 1: General Guidelines for Reliable Output. Basic steps and information you should know when working with 
or processing files with transparency from Illustrator 9.x.

Section 2: Solutions for Your Workflow. In-depth how-to information about specific issues you might encounter in 
jobs that have transparent content.

Section 3: Controlling Flattener Settings & Results. How to use the controls in Adobe products for managing 
flattening and transparency.

 

Applications covered by this document 

 

This document is primarily about how to work with Adobe Illustrator 9.x files that contain transparency. It also 
provides some information about using Adobe Acrobat® 5 for printing PDF 1.4 files that have transparency. This 
document will be updated as more Adobe products are enhanced to support transparency workflows. Check 
www.adobe.com for updates. 

 

Note: 

 

Use Illustrator 9.02 for the best results. This update is available at no charge from www.adobe.com.
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Section 1: General Guidelines for 
Reliable Output

Section Overview

This section describes the basics of the new transparency model, how it could affect your work, and the general 
guidelines to follow for achieving good results.

New transparency options present new prepress challenges
The need to handle transparency and transparency effects (such as drop shadows) for images, text, and line art is 
standard practice in high-end prepress environments. In fact, you are already quite familiar with that in Adobe 
Photoshop®.  

Adobe has recently implemented a new transparency model that allows graphic designers to apply transparency and 
transparency-based effects to almost any object, including text, vectors, gradients, and imported graphics. This 
support is implemented in Adobe Illustrator 9.x.

The new transparency model allows you to optimize certain existing workflow practices. For instance, you are 
probably using Adobe Photoshop to add drop shadows to type and vignettes to images. With a tool such as Illustrator 
9.x, you can apply effects like these directly to the affected objects. In addition, the effects remain “live” so that when 
type is edited, for example, the applied drop shadow changes with it. You should also be able to directly output 
layouts containing creative transparency effects without recreating them in Adobe Photoshop as a complete raster 
file. 

Like any new technology, however, the upgraded transparency capability also exposes different and sometimes 
unfamiliar results across applications and file formats. Thus you may already be receiving jobs with transparent 
design elements and have been unable to achieve results that are acceptable to you or your customers. 

There is a lot to learn about Adobe’s new approach to transparency and how it changes existing workflow practices. 
The degree to which you will need to study this guide and deepen your understanding of transparency will depend 
on a number of factors, including: 

• The complexity of the jobs you receive.

• The prepress tools you use.

• The workflow techniques you employ.

• The kinds of devices you prepare output for.

The rest of this section gives you enough information to understand the basic issues around transparency, address 
many common problems, and process most jobs successfully. Section 2 goes into greater detail about handling trans-
parency in specific workflow scenarios.
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How transparency changes your workflow

Adobe’s new transparency capabilities may affect your prepress workflow in the following ways:

1 Three types of files you typically receive could now contain content to which transparency has been applied:

• Native Adobe Illustrator 9.x files. 

• Illustrator 9.x graphics that have been saved as PDF or EPS. 

• Page layout files that contain artwork exported as PDF or EPS from Illustrator 9.x.  

2 The transparent design elements in these files may not have been optimally prepared (“flattened”) for printing or 
separations, so you may have to adjust or compensate for this in your workflow. Flattening is a necessary step that 
converts all transparent design elements into a format that PostScript devices can print. It should be done as late in 
the process as possible—preferably by you, the prepress service provider.

3 Your ability to inspect and adjust for inadequate flattening depends on the format of the files you receive:

• Illustrator 9 native and Illustrator 9 EPS files let you use Illustrator 9 to inspect and adjust the flattening settings 
for optimal output from all applications that can read and print these formats. 

• PDF files that have been saved from Illustrator 9 with the “Preserve Illustrator Editing Capabilities” option 
selected (in the Adobe PDF Format Options dialog box) will let you use Illustrator 9 to restore live transparency 
and inspect and change the flattener settings. 

• Transparent artwork received in any other format will have been flattened and may not print as you expect on 
your high-end equipment. You will be unable to inspect or adjust the flattening settings for these files, although if 
you have access to the original Illustrator 9 artwork you can re-save them with more appropriate settings. These 
formats include PostScript, Illustrator 8 EPS (or earlier), DCS, PDF 1.2 and 1.3, GIF, JPEG, BMP, and non-
Photoshop 6.0 TIFF images.

Note: When saving as PDF in Illustrator 9, PDF 1.3 is listed as “Acrobat 4” in the Save As dialog box, and PDF 1.4 is 
listed as “Acrobat 5.”

The more you understand flattening and the characteristics of the target output device (e.g., its resolution and its 
ability to reproduce the colors you have chosen for a given job), the easier it will be to choose how and when you 
flatten your customers’ documents. Also, the later in your workflow that flattening occurs, the more likely you are to 
achieve acceptable, repeatable results. 

TRANSPARENCY CAN SHOW UP IN MANY WAYS. 

While many customers apply transparency using the Illustrator 9.x Transparency palette, not all uses of transparency are obvious in a 
file. Transparency is also automatically applied as a side effect of using some styles, brushes, live effects, and non-normal blending 
modes (e.g., Add or Multiply). Transparency may also be introduced when a designer incorporates previously created content that 
contains live transparency  in the Illustrator 9 file.
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Why you can experience unexpected transparency results 

All transparency must be flattened

The Adobe PostScript® language does not support Adobe’s transparency in native device-independent format. For 
this reason, PostScript desktop printers, Adobe PostScript Level 2 high-end printers, and most Adobe PostScript 3 
high-end production devices and RIPs cannot accept and process “live” transparency information on the fly.

To print correctly, all transparent objects in a graphic must, at some point in every workflow, be flattened. Flattening 
converts the objects from a device-independent format into a format that is visually equivalent but does not contain 
transparency; this format can be represented in PostScript. In Adobe applications, flattening automatically occurs 
any time the transparent artwork is either: 

• Printed from its native program (e.g., Illustrator 9) or a program that supports the originating program’s native 
format. 

• Saved in a file format other than a native format, so it can be placed or linked to other applications in the design 
or prepress workflow. Typically, a file is saved into a non-native, flattened format using “Save As” or “Export” to 
make an EPS or another file, or when the document is converted to PostScript by printing to disk. Flattened 
formats include PostScript, EPS, DCS, PDF 1.2 and 1.3, GIF, JPEG, BMP, and non-Photoshop 6.0 TIFF images. 

NOT ALL EPS FILES ARE CREATED EQUAL

Illustrator 9.x can save files in its own (Illustrator 9) EPS format, as well as in EPS formats that are compatible with earlier versions of 
Illustrator, such as Illustrator 8 or Illustrator 7. 

Transparency is always flattened when saved to EPS. However, Illustrator 9 EPS (if it has not been re-saved by another program after 
being created) retains the transparency information within its code, enabling these files to have their live transparency restored if the 
file is opened again in Illustrator 9.x.

THE FUTURE OF PRINTING LIVE TRANSPARENCY: POSTSCRIPT 3

PostScript 3 printers that support Adobe PDF 1.4 (Acrobat 5) files will accept and process the “live” transparency that can be saved in 
PDF 1.4 files. This capability is built into the new PostScript Language version 3015, which was released to Adobe OEM partners in spring 
2000.
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How flattening changes the artwork

At its simplest, the process of flattening converts all the overlapping elements in a stack of transparent objects into a 
format that captures the look of the original transparency for printing. 

To achieve this effect, an Adobe application’s flattener software examines the interactions at every point of the trans-
parency and does four things to the artwork:

1 It cuts the transparent art apart and represents overlapping transparent regions by discrete, abutting elements, 
each with its own color. (See Figure 1.)

Figure 1. A Simple Example of Flattening.
Flattening cuts transparent art apart to represent overlapping areas as discrete pieces that are either vector objects or rasterized areas. This ex-
ample involves only vector objects. As artwork becomes more complex (mixing images, vectors, type, spot colors, overprinting, etc.) so does the 
flattening and its results.

2 It retains the integrity of the original transparent objects as much as possible (e.g., type stays type, vectors stay 
vectors), but it may rasterize some type or artwork when necessary, based on the file’s complexity and the flattener 
settings in effect at the time.

3 It sets the resolution of rasterized areas to a specific, device-dependent value that is defined by the flattener settings 
in effect at the time. 

4 If overprinting is also used in the file, the flattener, by default, may process the overprinting objects as it would 
process overlapping transparent objects. See “Overprinting may not be preserved:” on page 6 for details about when 
this can occur.

The bottom-line effects on your workflow and output

Flattening makes several alterations that directly affect prepress workflows and output quality. If the original Illus-
trator 9 artwork files are available, you can often fix these issues (see Sections 2 and 3).

Transparency will not be “live” and editable anymore: Although the result still looks transparent, the formerly 
transparent objects in flattened artwork are opaque, and will not be transparent to other objects in other applications 
(i.e., it is no longer “live” to other objects). In addition, some of the original objects may themselves be transformed 
into less editable formats. (For example, vectors can become rasterized and type may become outlines or be 
rasterized.) 

Adjusting transparency attributes and objects after flattening requires going back to the original source file, making 
changes, and then exporting (flattening) it as a new file. This is analogous to standard editing practices with imported 
graphics today. 

For more information, see the inset, “Going Native—Keeping Transparency Live and Editable” on page 10.

Original Artwork Flattened Artwork
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Rasterization may cause visible changes: The flattener’s need to occasionally convert vectors to rasterized areas (or 
type to outlines) can produce undesirable visual results, such as jaggies, color stitching1, or thickened stroke widths. 
This is especially true when the flattener rasterizes only a portion of a larger, more complex design. The flattener’s 
decision to rasterize is based on the type of objects being flattened (type, gradients, spot colors, and so on), on the 
file’s complexity, and on the flattener’s Quality/Speed settings that are in effect at the time you Save As/Export or 
print.  

Resolution may not match your device: Flattening can create rasterized regions that have a resolution that is signif-
icantly lower than your final output device resolution. This is because the flattener has no knowledge of the final 
output device or its parameters. Instead, it applies the resolution settings that are in effect from the native application 
during flattening. Objects that remain in vector format will remain device independent and will correctly scale to 
match the resolution of the output device. 

Colors may be unexpectedly changed: The use of transparency can change colors in several unexpected ways. First, 
applying certain blending modes to objects in a document—another way of working with transparency—means the 
flattener will redefine the mix of process colors used to represent the overlapping regions. This may introduce process 
inks that the document’s designer did not originally specify. 

Second, if color management is involved in the workflow, colors involved in transparency may become more device-
dependent and may not match your actual press conditions after being flattened. This can happen if you have not 
carefully chosen the working space profile for the document. 

Finally, the use of spot colors in conjunction with transparency may yield unexpected results. Correct spot color 
separations will only be obtained when the Illustrator 9 document is saved as Illustrator 9 EPS. Exporting in other 
formats (e.g., Illustrator 8 EPS or PDF 1.3) will result in spot colors being converted to process equivalents.

Overprinting may not be preserved: When overprinting instructions are applied to objects in a file that also 
contains transparency, the flattener may become involved in processing the overprinting. One of three things will 
happen, depending on how the overprinting objects interact with other elements in the file:

• For objects that sit completely over other objects in the file (i.e., do not touch the background), the overprinting 
instructions between objects in the file will be preserved. That is, what you see on press will be what you expect. 

• For objects that sit completely over the background, overprinting instructions will not be preserved because the 
flattener, by default, will process the overprinting objects as it would process overlapping transparent objects. That 
is, it will cut apart and convert the overprinting areas into discrete, abutting objects. Visually, the output looks as 
if overprinting had been applied. However, all the PostScript instructions that would create plates to overprint inks 
on press are stripped out by the flattener, and the press results will not be what you expect. 

• For objects that straddle other objects and the background, the flattener will retain overprinting instructions 
wherever it can—that is, only for those regions that sit over other objects rather than the background. Any regions 
that sit only on the background will be flattened as described in the second circumstance above. 

When the resulting flattened file is placed into a layout, it will completely knock out any objects in that layout over 
which it is placed. Depending on how the designer applied overprinting in the original file, this behavior may or may 
not be acceptable. 

Note that the flattened results described above work only when the artwork is saved in the Illustrator 9 EPS file 
format or printed directly from Illustrator. Overprinting instructions will not be preserved at all when the file is saved 
as an Illustrator 8 EPS or PDF 1.3 file. These overprinting instructions can also be ignored when printing to a 
composite printer (i.e., an inkjet printer) from Illustrator, which can be desirable for proofing. See “Printing Separa-
tions” in Section 2. 

1. Color stitching is the visible color transition between objects whose coloring would otherwise be expected to be identical. It most commonly occurs when
a portion of a vector object is rasterized by the flattener.
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Transparency effects may be lost after image replacement: When the flattener encounters a transparent region of a 
document that involves images (e.g., transparent type and a drop shadow that fall over an image), it will use whatever 
image data is present during flattening to render the overall effect requested. Thus if the image involved was only a 
low-resolution proxy image, that image information will be used. When that proxy is subsequently “swapped out” 
with a final, high-resolution image (using OPI, APR, or manual methods), the rendered transparency effect will be 
lost.

Transparency information can be retained by performing image replacement prior to flattening and embedding 
graphics in Illustrator 9 instead of linking them (see “Using Image Replacement” in Section 2). 

The cumulative effect

The variables listed above are not the only ones that can affect flattening results. Others include the complexity of 
the transparency, whether fonts used in the transparency are available during flattening, and whether external files 
used in the transparency are linked or embedded. Even the file format and settings used during flattening can make 
a striking difference in the final printed piece.

As these and other flattening issues accumulate, it becomes clear how some transparent elements and files might not 
flatten and print as well as others. The following section provides useful tips for achieving successful output for 
standard jobs. 

Recommendations for successful output 
To minimize the impact of transparency-related issues, Adobe recommends the following for you and your 
customers:

• Whenever possible, use file formats that preserve live transparency—e.g., native Adobe application files (Illus-
trator 9)—as hand-off files or source files for placement in layouts or other documents.

Reason: You have control over the flattener and resolution settings in your shop, up to the time you must print 
or save the artwork to a non-native file format (such as to PostScript for trapping).

• Save files in Illustrator 9 EPS format for all transparent artwork that is to be used in a page layout application, 
especially if you intend to make separations. 

Reason: Illustrator 9 EPS correctly preserves spot color plates, which otherwise are not retained during flattening, 
so this format is suitable for separations. More importantly, you can open Illustrator 9 EPS files in Illustrator 9.x 
and adjust flattener and resolution settings to match output conditions in your workflow.2

• Do mix overprinting and transparency in the same document if the actual on-press effects depend on 
overprinting, such as spot color tints over an image or manually added traps.

Reason: The presence of transparency anywhere in a document triggers the flattener to analyze overprinting as a 
form of transparency. In some design circumstances, the flattener will need to simulate the overprinting and 
remove overprinting instructions from the PostScript stream.

2. An Illustrator 9 EPS remains editable only if it retains the  Illustrator 9-specific information that’s embedded in the file. Once the file is saved to a non-
Illustrator 9 EPS format, this information is removed, and the file loses its ability to be flattened again. For instance, placing an Illustrator 9 EPS into a page
layout application and then saving the resulting file as EPS  strips out the Illustrator 9 information. That EPS can be opened in Illustrator 9, but you cannot
edit its transparency or flattener properties. Many techniques described in this document depend on the integrity of the exported Illustrator 9 EPS file.
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• When using PDF 1.3 for separations, make sure the PDF is created in the right way to support the transparency: 
first export the Illustrator document as Illustrator 9 EPS, then use Acrobat Distiller® to make a PDF 1.3 file. (See 
“Working with Placed Graphics” in Section 2.)

Reason: Spot colors and fonts will not be preserved in the flattening process that is used when you export into 
PDF 1.3 directly from Illustrator 9.

• If you are flattening a document, inspect it to:

Determine if spot colors are being used. This will require that the file be saved in Illustrator 9 format. (See 
“Printing Separations” in Section 2.)

Determine if overprinting and transparency are being used together in the document. During flattening, the 
overprinting might be simulated, and the overprinting instructions might be removed. (See “Overprinting 
Instructions are Lost” in Section 2.) 

Determine (if possible) whether the Difference, Exclusion, Hue, Color, Saturation, or Luminosity blending mode 
was used in the document. Once flattened, these blending modes will not separate as expected in regions that use 
spot colors with these blending modes. 

Make sure all the fonts are present and properly installed. Otherwise, the flattener will substitute them with fonts 
that may not fit the original text’s bounding box in the same way, and it cannot be corrected later. 

Look for any low-resolution proxy images (FPOs). A document must be “fattened”—contain all high-resolution 
final images—before it is flattened for proper results. This means performing image replacement manually before 
flattening a document. In Illustrator 9 it also means embedding rather than linking to images involved in trans-
parency. (See “Using Image Replacement” in Section 2.)

If you are using color management, be sure the document’s working color space is set to your intended output 
device before flattening. This ensures that transparent objects are assigned suitable in-gamut colors. (See 
“Handling Color Conversions” in Section 2.)

• Embed (do not link) EPS and bitmap images that are placed as part of an Illustrator 9 transparency.3

Reason: Linking stores an image’s information outside of the source document, so the flattener cannot read the 
data if the linked file is involved in a transparency. Linked files will print first, beneath everything else on the page. 
Embedding the file in Illustrator 9 enables the flattener to correctly process the file’s contents for transparency-
based effects.

• Review a document’s current Quality/Speed flattener settings and adjust to best match final output conditions. 
(See Section 3.)

Reason: The flattener settings you choose can greatly affect the quality of the printed piece. If you flatten before 
separations, use the highest quality setting for the best results. For quicker proofing, lower quality settings may be 
acceptable. 

• Review the current Rasterization Resolution settings and adjust as appropriate for the final output device’s 
resolution and line screen. (See Section 3.) 

Reason: If this setting is too low, stitching artifacts may occur. Generally, the Rasterization Resolution should be 
no less than 2x your intended line screen (e.g., rasterize at 300 ppi for 150 lpi output) and no more than the full 
resolution of the intended output device (although this can result in significantly larger flattened files). Your shop’s 
standard may vary.

3. This technique will not work with DCS 2.0 (pre-separated), duotone, tritone, or quadtone files because Illustrator 9 cannot embed these types of graphics.
These files are often used when creating images in Photoshop for use in Illustrator 9.
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• Review the current Raster Effects Resolution settings (if raster effects are used) and adjust as appropriate for the 
final output device’s resolution and line screen. Note that adjusting this setting will change the size and appearance 
of certain pixel-based raster effects in the file. (See Section 3.)

Reason: If this setting is too low, stitching artifacts may appear. Typically, the Raster Effects Resolution should 
match what you use for drop shadows created in Photoshop, which might be less than the resolution used for 
images. Your shop’s standard may vary. 

• If you are unsure about the effects that flattening will have on a document, run proofs at different flattener (and 
related rasterization) settings to ensure that you are comfortable with the results before going to plate. 
(See Section 3.)

Reason: Some files with transparency print just fine the first time out. Others require fine-tuning. Making a 
composite proof may be a less expensive way to verify any changes that may be needed for the file before making 
film or plates. 

Where to go next 
The more you know about transparency and the effects of flattening, the better prepared you will be to intercept 
problems. 

This section provided a high-level overview of what to expect when receiving and processing transparent files. We 
encourage you to read Sections 2 and 3 to understand:

• How to address the effect of flattening on specific workflow steps.

• How to use the flattener controls in Adobe software.

HOW TO CONTROL FLATTENING IN ILLUSTRATOR 9

Section 3 of this document describes the four settings available in Illustrator 9.x for controlling variables during flattening. These 
settings are:

The flattener’s Quality/Speed setting (File>Document Setup>Transparency panel)

The Rasterization Resolution setting (File>Document Setup>Printing & Export panel)

The Mesh Resolution setting (File>Document Setup> Printing & Export panel)

The Raster Effects Setting (Effects>Rasterize>Raster Effects Settings)

WHY ILLUSTRATOR 9 EPS FILES—AND WHY NOT PDF 1.4 FOR NOW?

You should ask your customers to save artwork that uses transparency in Illustrator 9 EPS format before placing it  into other applica-
tions. Currently, only Illustrator 9 EPS lets you go back and revise flattener settings to correct problems before they occur. 

This is because Illustrator 9 EPS format holds all the pre-flattened transparency information inside of it. You can open the Illustrator 9 
EPS in Illustrator 9 and restore the “live” transparency objects for editing and resave with new flattener settings.

PDF 1.4 supports live transparency in a similar manner. However, there are not yet enough high-end prepress tools and RIPs available 
to take advantage of it as an application-neutral exchange format that can also produce high-end color separations.
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GOING NATIVE—KEEPING TRANSPARENCY LIVE AND EDITABLE

Adobe’s transparency attributes stay in a “live and fully editable” form while in their native application or one that supports native file 
formats. This means:

They are “live” in that they will interact with other objects that are placed beneath them, allowing those objects to show through the 
transparency. These objects also retain a very high degree of (or complete) device independence.

They are “editable” in that the transparency attributes and/or transparent objects can be freely altered and changed to the extent that 
the receiving application can support such editing. (For example, some applications may allow you to reduce the opacity of type, alter 
the color/shape of a drop shadow, or edit transparent text.)

LIVE AND EDITABLE DEPENDS ON FORMAT AND APPLICATION

Transparent content is both live and editable within the application in which it is created. It can also be both live and editable when 
placed as a native file within another document. The extent to which it is editable in the receiving application depends on the editing 
features of that application. 

Transparent content is neither live nor editable when placed as a non-native (i.e., flattened) file within another document. The notable 
exception to this is the Illustrator 9 EPS format. This format includes additional application-specific information that allows Illustrator to 
“reconstitute” transparency in a live and editable form. 
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Section 2: Solutions for Your Workflow

Section Overview

This section describes what you can to do to minimize problems or prevent them altogether in standard print 
production workflows.

Transparency-related issues to watch for 
Despite your best efforts to head off transparency problems, some transparency issues will almost always arise. 
Typical changes to be concerned about include, in order of likelihood of occurrence:

1 Spot colors may convert to process.

2 Overprinting instructions may not be preserved.

3 Vector objects may get rasterized at too low of a resolution.

4 Type may get merged into (“baked into”) low-resolution images. 

5 Hairlines and strokes may fatten (generally only a problem on lower resolution output devices).

6 Type may be converted to filled strokes (i.e., thicken).

7 You may get unexpected or missing plates when printing color separations. 

Some additional transparency interactions currently have no workarounds for optimal printing. New versions of 
Adobe software will likely address some of these interactions. However, until that happens, be on the alert for the 
following elements when they are mixed with transparency:

• Pre-separated content (DCS files).

• Duotone, tritone, quadtone, images.

• Placed (linked) files. 

• Images that are to be replaced after flattening has been done (e.g., in workflows using an OPI server). 
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Go with your own flow

The degree to which any of the effects of flattening will affect your work often depends on whether the flattened 
results are appropriate (or not) for the next step of your workflow. 

For instance, type that gets converted to outlines cannot be changed with a touch-up tool. If the file is to be immedi-
ately color separated for printed output, this is unlikely to be an issue. At other points in the workflow, however, it 
may cause a problem. Similarly, you may not be able to map one spot color to another color after flattening, but if 
the next workflow step is trapping, you may not need to.  

Because it is all a tradeoff, the goal is to maximize the value of transparency and minimize the effects of the transfor-
mation to a flattened file.  

TREAT FLATTENING LIKE PRE-SEPARATED CONTENT 

It is useful to understand that workflows involving flattened art are not dissimilar to those that involve pre-separated content—
something you are already familiar with. 

With pre-separated files, corrections  can only be made by going back to a composite format. You cannot convert a spot color to process, 
fix a trap, change image resolution, or replace an image after separations are done. Similarly, flattening binds artwork into a represen-
tation that precludes making certain changes unless you return to the original version. 

This is why it is so important to use Illustrator 9 native or Illustrator 9 EPS files. Illustrator 9 EPS lets you return to a live, unflattened 
version of the transparency to change not only the transparency attributes, but also the flattener settings for your particular output 
device.
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About these solutions 

You are unlikely to encounter significant problems if you follow the recommendations in Section 1. However, when 
a file requires some special attention, you may find a solution for it here. Figure 2 illustrates the conventions used in 
this section to present the problems and solutions.

Figure 2. How the Solutions Are Organized and Presented.
A. Related Problems are organized by the Workflow Step at which they typically occur during prepress.
B. Each Workflow Step lists specific Common Scenarios in which the Problem will be encountered. 
C. The “Effects of Flattening“ explains how flattening can influence the expected output.
D. Each Problem statement has its own subsection. 
E. “What is happening” gives a behind-the-scenes look at what is going on during flattening or printing.
F. Each Problem has one or more specific Reasons. Solutions are presented to correspond to each Reason.
G. Some Problems include related Additional Information at the end. 

Table 1 summarizes the Workflow Steps in this section, the most common Problems you may encounter, and where 
to find potential Solutions. 

Note: This section documents some of the most important and common problems of working with transparency files. 
Fixes for some of these will be addressed in future releases of Adobe software. You may, however, encounter other 
problems that have not yet been reported. If you can’t find a particular problem statement in here, look for an update 
to this document on the Adobe web site, or contact Adobe Technical Support for further assistance.

A

B

C

D

E

F

G

Printing Separations

Common Scenarios

Printing host-based color separations

Printing in-RIP color separations

The Effects of Flattening

Host-based separations (such as those from Illustrator 9, QuarkXPress™, or Adobe InDesign® 1.5.2 and earlier) and in-RIP 
separations require that transparent artwork be flattened before separations are made. 

•   If the artwork is in native Illustrator 9 format, the flattening will occur as you print separations from Illustrator. Neither
InDesign 1.x nor QuarkXPress will properly flatten native Illustrator 9 documents.

•   If the artwork has been exported from Illustrator 9 in a format such as EPS for placement in other separations software,

the flattening already occurred in Illustrator 9.

•   If the artwork has been printed to PostScript for in-RIP separations, the flattening already occurred wherever the file was
first converted to a non-native format in the workflow.

Flattening (or certain flattened file formats) can affect separations by changing spot colors to process, pre-processing and 
removing overprinting instructions, or altering which plates are produced. 

Problem:  Spot colors are being converted to process. 

What is happening

The flattened file is saved in a format that does not preserve spot colors. In addition, spot colors will be converted to process 
equivalents as a side effect of using certain filter effects such as a Gaussian Blur.

Reason:  The artwork was not saved as Illustrator 9 EPS.

Solution: Obtain the original Illustrator 9 file and save it as Illustrator 9 EPS. This file format properly retains spot colors 
for separations.

Note: Even if saving to Illustrator 9 EPS, some colors may still be converted to process because there is no other way to represent 
the requested effect. See additional Reason/Solution sections below.

Reason:  The artwork was saved as Illustrator 9 PDF 1.3 directly from Illustrator 9 (instead of going through Distiller). 

Solution: Obtain the original Illustrator 9 file and create a PDF 1.3 file by first saving it as an Illustrator 9 EPS or PostScript 
file from Illustrator 9, then using Distiller to create a PDF 1.3 file. This approach properly retains spot colors. 

Additional information

Use Illustrator 9.0.2 for the best results with spot colors.
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Table 1: Workflow Steps That Can Be Affected by Transparency

Workflow step Issues to know about Potential Solutions

Printing color separations (host-
based or in-RIP)

• Spot colors may convert to process See page 15.

• Overprinting instructions may be lost See page 16.

• Plates may be unexpected or missing See page 16.

• Black overprinting from RIP may not work See page 17.

Creating proofs (composite desk-
top, composite digital contract, or 
film-based digital contract)

• Composite proof may not show 
overprinting as it is seen on screen

See page 18.

• Overprinting may not show for placed 
Illustrator 9 files.

See page 18.

Working with placed graphics • Graphics may not interact with 
transparent artwork

See page 20.

• EPS graphics may print poorly See page 21.

• White box may appear in EPS graphics and 
cover objects beneath

See page 21.

• Text converted to outlines may become 
bitmapped

See page 22.

• Type over image may be rasterized See page 22.

• Placed native Illustrator 9 files may 
produce unexpected results

See page 22.

• Duotones, DCS, etc., files will not print as 
part of transparency

See page 23.

• Spot colors or overprinting may not print 
from placed PDF 1.3 file

See page 23.

• Placed PDF 1.3 file may print poorly See page 24.

• Placed PDF 1.4 may fail to place, print, or 
separate

See page 24.

• Illustrator 9 screen redraw may be slow See page 24.

Performing image replacement 
(OPI, APR, or manual)

• Transparency with image may be poor or 
lost after replacement

See page 26.

• Low-resolution version of image may print See page 26.

Handling color conversions • Output device may not be able to 
reproduce some colors 

See page 27.

• Colors may become jaggy or irregular 
(color stitching)

See page 28.
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Printing Separations

Common Scenarios

Printing host-based color separations

Printing in-RIP color separations

The Effects of Flattening

Host-based separations (such as those from Illustrator 9, QuarkXPress™, or Adobe InDesign® 1.5.2 and earlier) and 
in-RIP separations require that transparent artwork be flattened before separations are made. 

• If the artwork is in native Illustrator 9 format, the flattening will occur as you print separations from Illustrator. 
Neither InDesign 1.x nor QuarkXPress will properly flatten native Illustrator 9 documents. 

• If the artwork has been exported from Illustrator 9 in a format such as EPS for placement in other separations 
software, the flattening already occurred in Illustrator 9.

• If the artwork has been printed to PostScript for in-RIP separations, the flattening already occurred wherever the 
file was first converted to a non-native format in the workflow. 

Flattening (or certain flattened file formats) can affect separations by changing spot colors to process, pre-processing 
and removing overprinting instructions, or altering which plates are produced. 

Problem:  Spot colors are being converted to process. 

What is happening

The flattened file is saved in a format that does not preserve spot colors. In addition, spot colors will be converted to 
process equivalents as a side effect of using certain filter effects such as a Gaussian Blur. 

Reason: The artwork was not saved as Illustrator 9 EPS. 

Solution: Obtain the original Illustrator 9 file and save it as Illustrator 9 EPS. This file format properly retains spot 
colors for separations.

Note: Even if saving to Illustrator 9 EPS, some colors may still be converted to process because there is no other way to 
represent the requested effect. See additional Reason/Solution sections below. 

Reason: The artwork was saved as Illustrator 9 PDF 1.3 directly from Illustrator 9 (instead of going through 
Distiller). 

Solution: Obtain the original Illustrator 9 file and create a PDF 1.3 file by first saving it as an Illustrator 9 EPS or 
PostScript file from Illustrator 9, then using Distiller to create a PDF 1.3 file. This approach properly retains spot 
colors. 

Reason: A filter effect, such as a Gaussian Blur, that does not preserve spot colors, was applied to one or more 
spot colored objects.

Solution: There is currently no workaround for this problem.
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Problem:  Overprinting instructions are lost. 

What is happening

Either the flattened file is saved in a format that does not preserve overprinting instructions, or the file contains 
overprinting objects that fall completely or partially over the background of the file. Both of these scenarios only 
apply when the file contains both transparency and overprinting. Files that contain only overprinting will not be 
flattened and will retain overprinting instructions.

Reason: The artwork contained both transparency and overprinting and was not saved as Illustrator 9 EPS. All 
overprinting instructions were processed by the flattener and the results of overprinting simulated in the resulting 
file.

Solution: Obtain the original Illustrator 9 file and save it as Illustrator 9 EPS. This file format properly retains 
overprinting.

Reason: The artwork contained both transparency and overprinting but some of the overprinting objects (or 
portions of those objects) covered the background. The overprinting for those objects (or portions of those 
objects) was simulated by the flattener, and the corresponding overprinting instructions were removed.

Solution: There is generally no way to work around this problem unless overprinting instructions are re-applied 
to the affected objects after flattening. This is best done using options available from within your layout program 
or proprietary printing system. This limitation will be addressed in future versions of Illustrator. 

Additional information

This problem also applies to Illustrator’s Filter > Color > Overprint Black option.

Problem:  Unexpected plates are created, or expected plates are missing, when separations are 
generated.

What is happening

The effects created by applying certain blending modes to overlapping objects may introduce process inks that the 
designer did not originally specify. For example, if a document that uses only cyan and black process inks includes 
objects to which the Difference blending mode has been applied, the result will be the unexpected introduction of 
magenta and yellow process inks. When the document is separated, four rather than two plates will be created.

Reason: The artwork uses Difference, Exclusion, Hue, Color, Saturation, or Luminosity blending mode.

Solution: Creation of or removal of process color plates is a side effect of the design decision to use these blending 
modes. Aside from consulting with your designer, there is no workaround for this issue.
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Problem: Black type overprinting specified with a proprietary printing system does not work.

What is happening

Based on the flattener settings in effect at the time, some or all of the type in a document may have been converted 
into outlines or been rasterized. Proprietary systems that include options to set black type to overprint are therefore 
unable to recognize the type as type, so their setting does not work. As a result, the converted type will knock out 
whatever it is placed over in the final design.

Reason: Type was either rasterized or converted to outlines because the file is too complex, or the Quality/Speed 
setting is too low.

Solution: Obtain and open the original file in Illustrator 9 and review the Quality/Speed setting to be sure it is at 
level 5 (Highest Quality setting). If it is not, increase the Quality/Speed setting to level 5, resave as Illustrator 9 EPS, 
and try the black type overprinting again. Even at setting 5, the flattener may need to convert some type into 
outlines, in which case there is no other workaround to this problem. 

Creating Proofs

Common Scenarios

Creating composite desktop proofs

Creating composite digital contract proofs

Creating film-based digital contract proofs

The Effects of Flattening

Some composite printing/proofing systems can improve on the normal simulation of spot colors by using additional 
inks or colorants to extend the CMYK color gamut. Many other composite proofing devices rely on proprietary color 
conversion methods to convert custom spot colors into a proofing device’s reproducible color range or gamut. The 
composite usually matches on-press results better.

For either system to work, the device’s PostScript interpreter must be able to read the spot color names from the print 
stream. However, if flattening has converted spot colors to process color equivalents, the spot color names and color 
values are stripped out from the print stream, and the device’s color engine cannot perform the proper optimization 
or transformation. Therefore the results of a composite simulation may not be as good as those normally achieved 
with these special classes of composite printers. 



18
Solutions for Your Workflow
Problem:  The composite proof and on-screen preview of overprinting from Illustrator 9 do not 
match.

What is happening

Overprinting instructions that the flattener would normally process before printing a file are being ignored because 
of options set in the print dialog box. 

Reason: This occurs when printing composites from Illustrator 9 with the “Ignore Overprinting in Composite 
Output” setting turned on. 

Solution: Make a new composite proof from Illustrator 9 with the “Ignore Overprinting in Composite Output” 
option turned off (Print dialog box, Adobe Illustrator 9 panel).

Problem: A placed EPS file printed as a composite proof does not show overprinting.

What is happening

The receiving application is interpreting the EPS in a way that ignores the pre-calculated overprinting preview color 
information in the file. Instead, the application is using the file’s embedded color-separations information for 
printing the composite. There is nothing wrong with the exported EPS, and it will separate correctly. Only the 
preview is being affected. 

Reason: The receiving application cannot read the EPS file’s overprinting preview information. 

Solution: The file will separate correctly: this is only a problem with the composite preview, and can, in effect, be 
ignored. If you need a proof of just the EPS file showing overprints, you can print the composite from a different 
application, such as Illustrator 9.x, that can read the pre-calculated overprinting preview color information. 
However, if you need a proof of the EPS in context, there is currently no specific workaround for this issue.
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Working with Placed Graphics

Common Scenarios

Placed graphics used as part of transparent art in Illustrator 9

EPS, native Illustrator 9, and DCS/multi-tone graphics placed from Illustrator 9 into other applications

Placing PDF 1.3 files

Placing PDF 1.4 files

The Effect of Flattening

There are two circumstances that can create transparency-related issues with placed graphics (EPS, JPEG, PDF, and 
others):

• A graphic is being included as part of the transparent artwork in Illustrator 9 or a transparent-savvy application. 
Graphics must be embedded into Illustrator 9 for the flattener to process them correctly with the rest of the trans-
parency.

• An Illustrator 9 graphic containing transparency is saved as EPS for placement into another application that does 
not understand transparency (such as InDesign 1.5 or QuarkXPress). For some EPS formats from Illustrator, such 
as those meant to be compatible with earlier versions of the application (e.g., Illustrator 8) or PostScript Level 1, 
flattening can change spot colors to process, remove overprinting instructions, or alter which plates may be 
produced. It may also produce poor-quality output, such as shifts in resolution or color stitching.

Note: An Illustrator 9.x EPS file contains an EPS (PostScript) portion and a native Illustrator 9.x portion. When an 
Illustrator 9.x EPS file is placed in any application other than Illustrator, only the EPS portion is used. Which Illustrator 
version you prefer to work with determines your control over flattening. If you request Illustrator 8 EPS files, instruct 
your customers to adjust the Quality/Speed and resolution settings to suit your needs. You will be unable to adjust these 
settings after the file is saved in Illustrator 8 EPS (unless you have access to the original Illustrator 9 file and can resave 
it). If you request Illustrator 9 EPS files, you can add value to your services, and reserve the option to re-open and adjust 
values as needed.

A special note on Illustrator 9 EPS

Illustrator 9 EPS is encoded with two different PostScript descriptions of the colors used: 

• A description for separations, in which spot colors are retained but flattened (i.e., the plates cannot be changed). 

• A description for composite output, in which overprinting is simulated and spot colors are converted to process 
to match what is on screen. 

Additional PostScript logic built into the file automatically determines which description to use when the EPS file is 
RIP’d. This logic correctly recognizes “composite separation” devices, such as Extreme and PostScript 3 RIPs, and 
chooses the color description that is suitable for making separations.  

For more information, see also “Using Image replacement” in Section 2. 
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Problem:  Graphics or images placed into Illustrator 9 do not interact with transparent artwork 
when printed.

What is happening

The artwork is ignored by the flattener for inclusion in the transparency, and the element is printing at the bottom 
of the page layering.

Reason: The file is linked to, instead of embedded in, the Illustrator 9 artwork. (The flattener does not interact 
with linked files.)

Solution: Obtain the original Illustrator 9 document and graphic or high-resolution image, embed the 
graphic/image into the document (Links palette, Embed Image command), and print from Illustrator 9 or resave 
it as Illustrator 9 EPS. 

Note: Any EPS that is pre-separated (such as DCS artwork) or is a multi-toned image (such as duotones, tritones, and 
quadtones) will not embed in Illustrator 9. The solution described above of embedding an EPS to get proper trans-
parency interaction will not work with these kinds of EPS files. If the source file for the linked DCS is available, reopen 
the DCS file in the application that created it, and resave it in another format that Illustrator 9 can embed.

Additional information

It is possible that your customers will have only placeholder images in the file, so you will need to handle graphics 
replacement step yourself. If final color and artwork is being prepared off-site, you will need to obtain these files 
before proceeding.

As shown in Figure 3, if you do not embed the EPS graphic, Illustrator will display a warning when you place the 
graphic anywhere in a document that contains transparency effects, and again when you print the document if the 
linked graphic actually interacts with transparency. A small warning icon will also appear to the right of the EPS 
graphic’s name in the Links palette if that graphic interacts with transparency. Moving the placed graphic so that it 
no longer interacts with transparency causes the warning icon to disappear. (There may be a delay before this icon 
appears or disappears from the palette.) 

Figure 3
A. If you attempt to link an EPS file into an Illustrator document that contains transparency anywhere, Illustrator displays a warning. 
B. If the linked EPS actually interacts with the transparency, it presents an icon in the Links palette. 
C. When you print you will get another warning . The document may not print correctly unless you first embed the EPS graphic. 
D. This icon indicates that the placed EPS interacts with transparent artwork.

A

B

C

D
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Problem:  Placed EPS graphics print poorly.

What is happening

The flattened EPS file contains rasterized regions or color information that is inappropriate for the final output 
device, resulting in problems such as resolution and color stitching artifacts within the transparent areas. 

Reason: The Quality/Speed and Rasterization Resolution settings in effect during EPS export were not optimized 
for the output device. 

Solution: If the file is an Illustrator 9 EPS (or the original Illustrator 9 file is available), open it in Illustrator 9, 
reset the flattener’s Quality/Speed and Rasterization Resolution settings, and resave the file as Illustrator 9 EPS. 
See Section 3 for how to change these settings.

Reason: The original Illustrator 9 file contained files that are linked to, instead of embedded in, the Illustrator 9 
artwork. (The flattener does not interact with linked files, so it cannot produce the proper EPS output.) 

Solution: Obtain the original Illustrator 9 artwork and graphics, embed the graphics into the document (Links 
palette, Embed Image command), and print from Illustrator 9 or resave it as Illustrator 9 EPS for placement in the 
other application.

Problem:  A white box appears around a placed EPS and covers other objects in the layout.

What is happening

During export, the flattener processes transparency against an imaginary white background—the art board—and 
fits an opaque white rectangle (a matte) tightly around the artwork. In some cases, this rectangle may be insignif-
icant. In others, it may cover a large area relative to the artwork it contains. When the flattened artwork is subse-
quently placed in another layout, the matte may obstruct other design elements in the layout. This is particularly 
noticeable when the art uses live transparency effects, such as drop shadows, that are at the outermost edge of the 
graphic’s area.

Reason: The flattener has created a rectangular white matte around the transparency, but the matte is still visible 
beyond the edges of the transparent effect. 

Solution: There is no way to avoid creating the matte during flattening. However, flattening the artwork using the 
highest Quality/Speed setting (level 5) can, in some cases, reduce the size of the matte and solve the problem. 

If you are already using level 5 to flatten, then your only choice is to recreate the graphic to mimic the desired final 
of the art on the page. This involves recreating the placed graphic to include the design elements from the page 
layout program that will be covered by the rectangular white matte, and then resaving and placing the new graphic. 
To do so, edit the original Illustrator 9.x file or EPS graphic and incorporate copies of the affected page layout 
design elements (if possible). If these cannot be copied, you can recreate the affected layout design elements from 
scratch in Illustrator. In some cases, you may be able to use Photoshop for the same purpose. 
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Problem:  Text converted to outlines is bitmapped.

What is happening

Transparent areas can be flattened using a resolution that is different from that used in the document as whole. If the 
flattener’s Rasterization Resolution setting is lower than the resolution required by the final output device, and lower 
than the document at large, these areas may appear bitmapped and jaggy.

Reason: The flattener settings are not appropriate for the resolution and quality required by the output device.

Solution: Open the Illustrator 9 EPS or native Illustrator 9 file, increase the Rasterization Resolution and 
Quality/Speed settings to match the requirements of the output device, and export as Illustrator 9 EPS. 

Note: The Rasterization Resolution should not literally match the resolution of the output device. Rather, it should 
match the resolution you would use to reproduce images on that device (i.e., lpi x 2). See “Resolutions and their inter-
actions in Section 3 for details.

Problem:  Transparent type over an image is rasterized.

What is happening

A region of the image transparency is too complex for the given Quality/Speed setting, and the flattener has 
rasterized some or all of it, including any transparent type in the region. 

Reason: The Quality/Speed setting is too low (e.g., 2, 3, or 4). 

Solution: Obtain the Illustrator 9 EPS or original Illustrator 9 artwork and high-resolution image, increase the 
flattener’s Quality/Speed setting to level 5 for maximum quality, and print from Illustrator 9 or resave it as 
Illustrator 9 EPS. 

Problem:  A placed native Illustrator 9 file produces unexpected results on screen and in print.

What is happening

Native Illustrator 8 files and earlier were based on PostScript and could be parsed by any application that can read 
EPS files. Native Illustrator 9 files, by contrast, base the description of their graphic objects on the PDF 1.4 language, 
not on PostScript. Thus applications that try to import the document in its native format (i.e., PDF 1.4) cannot get 
the right results. This issue will disappear as more applications begin to support PDF 1.4.

Reason: The application cannot support the PDF 1.4 file format that is used for native Illustrator 9 files. 

Solution: Open the file in Illustrator 9 and export as Illustrator 9 EPS for placement in another application. 
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Problem:  DCS, duotones, tritones, and quadtones do not print as part of a transparency.

What is happening

The artwork is not being seen by the flattener for inclusion in the transparency, and the graphic is printing at the 
bottom of the page layering.

Reason: DCS (preseparated), duotone, tritone, and quadtone files (typically EPS, although multi-tone images 
may also be Photoshop or PDF) can only be linked to Illustrator artwork and be passed on to the printing device: 
they cannot be embedded. However, files that interact with a transparency must be embedded for the flattener to 
process them. 

Solution: For DCS images that use only process inks: If the source file for the linked DCS is available, reopen the 
source file in the application that created it, and resave it in another format that Illustrator 9 can embed (e.g., EPS). 
If you have the right software, you may be able to recombine the DCS file into a composite format, and resave it 
in another format that Illustrator 9 can embed.

For DCS images that use one or more spot color channels: If the source file for the linked DCS is available, reopen 
the source file in the application that created it, and resave it in another format that Illustrator 9 can embed (e.g., 
EPS). 

For multi-tone images: There is no workaround for duotones, tritones, and quadtones, which are represented 
using spot-colored rasters.

Note: Illustrator 7.x and later can separate linked DCS 1.0 files and multiple-file DCS 2.0 files that do not contain spot 
colors. Only Illustrator 8.x and later can separate linked single-file DCS 2.0 files or multiple-file DCS 2.0 files that 
contain spot colors. 

Problem:  Spot colors or overprinting does not print from placed PDF 1.3 files.

What is happening

Spot colors and overprinting instructions are not being preserved in the PDF 1.3 file. (This is a side effect of 
Illustrator 9’s PDF distilling process, not of the flattener.)

Reason: The artwork was saved as Illustrator 9 PDF 1.3 directly from Illustrator 9 (instead of going through 
Distiller). 

Solution: Obtain the original Illustrator 9 file and create a PDF 1.3 file by first saving it as an Illustrator 9 EPS or 
PostScript file from Illustrator 9, then using Distiller to create a PDF 1.3 file. This approach properly retains spot 
colors. 

Tip: Acrobat 4 or 5 will tell you which application produced a PDF file (File > Document Info). 

See also

For more information on working with overprinting, see the problem statement “Overprinting instructions are lost” 
under “Printing Separations” in Section 2. 
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Problem:  A placed PDF 1.3 file prints poorly (e.g., resolution artifacts or color stitching).

What is happening

The resolution settings or amount of rasterization done on the flattened file is creating abutting areas with different 
resolutions or color spaces. 

Reason: The Quality/Speed or Rasterization Resolution settings that were in effect for flattening are inappro-
priate for the intended output device. 

Solution: Obtain the original Illustrator 9 file set the proper Quality/Speed and Rasterization Resolution settings 
for the flattener (see Section 3 for details). Save the file as Illustrator 9 EPS, then use Distiller to create a new PDF 
1.3 file.  

Problem:  A placed PDF 1.4 fails to place, print, or separate.

What is happening

All live transparency in the PDF 1.4 file is ignored by a receiving application that does not support live transparency 
(such as InDesign 1.5 or QuarkXPress). Symptoms include an opaque version of the transparency, failure to print, 
or other inconsistent or unexplained results.

Reason: The file was not saved in a flattened format that the application can import. 

Solution: Open the PDF 1.4 file in Illustrator 9 and save it as Illustrator 9 EPS for placement in another appli-
cation. If you prefer to place a PDF 1.3 file, first save the PDF 1.4 document as an Illustrator 9 EPS or PostScript 
file from Illustrator 9, then use Distiller to create a PDF 1.3 file. 

Note: Any PDF 1.4 file that was created using Distiller 5 does not contain live transparency because PostScript or 
Illustrator 9 EPS files that are passed to Distiller are already flattened. For a PDF 1.4 file to retain live transparency, it 
must be created from Illustrator 9. Acrobat 5 can open, view, and print any PDF 1.4 file. When printed from Acrobat 
5, the file’s transparency will be flattened in the same way that it would be from Illustrator. See Section 3 for more 
details about the flattener settings in Acrobat 5. 

Problem:  Illustrator 9 screen redraw is slow when a document contains transparency.

What is happening

Adding transparency to a document can sometimes affect how often, and how quickly, Illustrator’s code redraws the 
screen as you move around in the application. In particular, having transparency in a file that also has several 
automatically updated linked graphics can cause the application to check for file updates more frequently than it 
might otherwise. Thumbnail previews of a transparency must also be updated each time an adjustment is made, 
which can slow down performance. The Illustrator 9.02 update provides many performance enhancements that 
improve screen redraw speeds. 

Reason: You are not using Illustrator 9.02. 

Solution: Download and install the free Illustrator 9.02 update from 
http://www.adobe.com/products/illustrator/update.html. 
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Reason: Illustrator is configured to automatically update linked objects when the original files change. 

Solution: Configure Illustrator to Manually Update links or to Ask When Modified links occur. (File > Prefer-
ences > Files & Clipboard > Files > Update links pop-up menu.) These options control how often Illustrator 9 
attempts to check linked files for changes, so they reduce the time required to redraw the screen. For more infor-
mation on these preferences, see Illustrator 9 online Help: Setting Up Artwork in Illustrator > Managing linked 
and embedded images > Specifying how to update links.

Note: Any external graphics that are involved in a transparency must be embedded, not linked, to the Illustrator 9 file. 
See the problem statement “Graphics placed into Illustrator 9 do not interact with transparent artwork when printed” 
under “Working with Placed Graphics,” above.

Reason: The Layers and/or Transparency palette is configured to display thumbnail previews. 

Solution: Turn off thumbnail previews. Choose Palette Options from the pop-out menu of the Layers palette, 
then uncheck Thumbnails > Layers. Choose Hide Thumbnails from the pop-out menu of the Transparency palette 
to turn off thumbnails.  

Using Image Replacement

Common Scenarios

Using manual methods

Using server-based OPI image replacement

Using RIP-based APR image replacement (part of Scitex printing systems)

The Effect of Flattening

Imported images are often involved in transparency. Customers may provide artwork with placeholder or sample 
images in place, expecting you to replace them with the high-resolution versions prepared separately. Flattening, 
however, only applies to whatever is present in the document at the time of flattening. This leads to two different 
issues: 

• The flattener in Illustrator 9.x does not follow links, so all external files must be present—embedded—to ensure 
the proper and expected results. See “Working with Placed Graphics” in Section 2.

• The flattener can only operate on whatever data is present at the time a document is exported or printed. Replacing 
images that interact with transparency (or to which transparency effects, such as feathered edges, have been 
directly applied) after flattening will result in partial or total loss of the desired effect.

Image replacement is usually done automatically, using a system such as OPI or APR (part of Scitex Brisque) just 
before or as part of final output. Neither of these automatic methods occur before flattening. Therefore, image 
replacement when transparency is involved must as a rule take place well before final output. 
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Problem:  Transparency effects are poor or lost after image replacement.

What is happening

The flattened file contains transparent areas that include low-resolution image information, and the high-resolution 
image is clipping out or replacing those areas, causing some effects to be lost or to appear “cut up” or “jaggy.” 

Reason: The file was flattened using the low-resolution version of the image, then the image was replaced with a 
high-resolution version. 

Solution: Obtain the Illustrator 9 EPS or original Illustrator 9 artwork and high-resolution image, manually 
embed the high-resolution image into the document (Links palette, Embed Image command), and print from 
Illustrator 9 or resave it as Illustrator 9 EPS. 

Problem:  The low-resolution version of an image is printing.

What is happening

The high-resolution image information is not available in the flattened graphic, and automatic image replacement 
is not working. 

Reason: The file was flattened using the low-resolution version of the image, and saved in a format that the 
automatic system cannot read. 

Solution: Obtain the Illustrator 9 EPS or original Illustrator 9 artwork and high-resolution image, manually 
embed the high-resolution image into the document (Links palette, Embed Image command), and print from 
Illustrator 9 or resave it as Illustrator 9 EPS. 
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Handling Color Conversions

Common Scenarios

Dealing with color gamut

Using color management 

Avoiding color stitching

The Effect of Flattening

The flattener causes colors to be converted in two ways that may not be desirable or expected:

• The color blending that occurs when rendering the appearance of transparency applied to objects may use a color 
space that does not provide a good match with the color gamut of the intended output device. For instance, colors 
may be converted from SWOP CMYK to Adobe RGB—two gamuts that do not generally match each other very 
well. 

• Spot colors, whether they are used in transparency or not, are converted to process to avoid color stitching artifacts 
that can often result if they were only converted to process when they interacted with transparency. This only 
occurs if the user chooses to save the document in a format other than Illustrator 9.x native or Illustrator 9 EPS.

Color stitching may also occur where vectors and rasterized objects abut in a flattened file because some printer 
drivers and proprietary high-end printing systems use different color management algorithms for processing vectors 
and rasterized graphics. While not a new problem, it is more acute when transparency is involved.

For information on handling spot color conversions, see “Printing Separations” in Section 2. 

Problem:  The output device cannot reproduce some colors in the flattened document.

What is happening

The flattener has created a new color to simulate the blend between two transparent objects, but it has used a color 
working space that does not match the color gamut of the intended output device.  

Reason: The working space profile of the document is different from that of the intended output device.

Solution: Obtain the Illustrator 9 EPS or original Illustrator 9 artwork. 

If you are using color management, choose a working space profile for the document that better or exactly matches 
final output conditions before flattening. This ensures that transparent objects are assigned suitable in gamut 
colors.

If you are not using color management, first make sure the document is using the correct color model for your 
intended output device (e.g., CMYK for an offset press using SWOP inks). If the results are still not acceptable, 
consider enabling the minimal amount of color management (by selecting the policy called “Color Management 
Off” in Illustrator and selecting a working space profile that matches your intended output device. See “Setting up 
color management” in the Illustrator 9.x Help document).
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Problem:  Colors are jaggy and irregular (color stitching).

What is happening

The flattener settings are causing regions to be cut up in ways that create visual discrepancies in colors that should 
otherwise match in the printed file (color stitching). The color areas appear jagged and may include unexpected or 
noticeable color transitions between raster and vector objects. See Figure 4.

Figure 4
Color stitching looks like jaggies with color.

Reason: The Quality/Speed setting may be too low for the flattener to make good choices about how it defines 
which vector regions to rasterize.

Solution: Obtain the Illustrator 9 EPS or original Illustrator 9 artwork, increase the Quality/Speed setting up one 
level, and print from Illustrator 9 or export it as Illustrator 9 EPS. This is less likely to trigger rasterization as easily. 
An alternative is to use the lowest Quality/Speed setting (Lowest/Fastest) and rasterize all areas of the illustration 
that contain transparency, so that color stitching isn’t an issue.

Reason: The printing device is making special optimizations for color depending on the type of object—e.g., 
image data is handled differently than vector data—or the printer has a particular color rendering dictionary 
enabled that is causing unexpected color output for vector and raster data. This is common for composite printers 
that allow for “intelligent” of “vivid” color treatment of images.

Solution: Disable these printer optimizations if possible before printing. This is usually done through a device-
specific “tab” in an application’s printer setup panel.
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Section 3: Controlling Flattener 
Settings & Results

About this section

This section explains how to flatten art in specific Adobe products, so you can make the best choices for your 
workflow or transparency job.

It is likely you will have to do the flattening to optimize transparent files for your target press conditions. You can 
either ask for native files and do the initial flattening in your shop, or you can open placed Illustrator 9 EPS files in 
Illustrator 9, flatten them again, and relink them in the layout. 

If you receive PDF 1.4 files that contain live transparency (these files are not flattened4), you can also use Illustrator 
9 or Acrobat 5 to flatten the file before or during printing. However, we recommend using Illustrator 9 because its 
editing and flattening options are more appropriate for high-end prepress workflows. 

Ideally, all flattening should be done as close as possible to the end of your workflow. Until all prepress tools are trans-
parency-aware, however, flattening will continue to occur upstream, when saving to Illustrator 9 EPS or other 
formats.

What are your points of control?
All Adobe products use the same flattener technology, but the features are exposed differently. In general, the 
flattener uses four interrelated settings that fall into two categories:

1 Quality/Speed of the flattening—controls the tradeoff between how much of the transparency will be rasterized, 
and how fast the flattening process goes. 

2 Resolutions used during flattening—controls what resolution (in pixels per inch) any rasterized transparent areas 
will receive during flattening. Three kinds of rasterization settings can come into play: 

• Rasterization Resolution—the resolution that the flattener applies to areas it needs to rasterize because they are 
too complex for the current Quality/Speed setting. The Rasterization Resolution is intended primarily for vector 
objects, but in some cases it may also be applied to type or images. 

• Raster Effects Resolution—the resolution that is applied to all raster effects (e.g., drop shadows or vignettes) that 
have been used in the file, whether or not they are involved in the transparency.

• Mesh Resolution—the resolution applied to any meshes and gradients that are involved in the transparency.5

How the flattener applies these three settings is explained in this section under “Resolution settings and their inter-
actions” on page 31.

4. Only PDF 1.4 files that are produced directly from Illustrator 9 will remain unflattened and retain their live transparency. PDF 1.4 files that were created
using Distiller are flattened and any transparency is no longer live.

5. The Mesh Resolution setting is not new with transparency. This setting manually controls the resolution of all meshes printed to PostScript Level 1 and
Level 2 RIPs that do not support the PostScript 3 “Smooth Shade” operator. The Mesh Resolution setting is completely ignored when mesh objects are not
involved in transparency and are printed to a PostScript 3 RIP.
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Your degree of control over flattening can also depend on the complexity of the original transparency content, and 
which file format was used to save the flattened document. Much like when compressing a JPEG file you choose 
between quality and compression, with flattening, you may have to trade off among many attributes. 

Quality/Speed settings
During processing, the flattener subdivides the artwork into specific regions and examines each region to determine 
if it has any transparent objects. For every region containing transparency, the flattener assesses whether the objects 
involved can be kept in their original form (e.g., vectors as vectors, type as type), whether they can be converted to 
a related form (e.g., type to outlines), or whether that entire region must be rasterized because of its complexity. 

The Quality/Speed setting lets you determine how hard the flattener will work to keep objects in their original form. 
Table 2 explains the five settings in detail, but in general:

• At Lowest/Fastest (setting 1), the flattener rasterizes all information in the file. 

• At Highest/Slowest (setting 5), the flattener tries to keep all transparency information in its original form. The 
flattener may not be able to represent all objects as vectors, however.

• Intermediate settings affect the degree to which the flattener rasterizes (or does not rasterize) complex areas of a 
transparency, as determined by the number of paths, the number of objects, the degree of overlap between the 
objects, and the type of objects in that area. 

The complexity of the document is the primary influence on flattening. In some cases, there may be no difference 
among the results you get with settings 2 through 5. In general, we recommend using only setting 1 or 5. Setting 1 is 
most appropriate for proofing to a low-resolution device. Setting 5 is best for final high-resolution work.6 Some 
regions that involve many intersecting transparent objects must be rasterized no matter what setting you select. 
Experiment with the settings to find the best result for your printing environment.

File size tradeoffs

In the end, choice of the Quality/Speed setting may not actually provide control over printing speed as indicated. For 
example, at the Lowest /Fastest setting, the entire document is rasterized, increasing the resulting file size. If the 
flattened file becomes large enough, printing speed actually decreases, as it takes longer to load and increases the 
burden on the RIP’s memory.

6. As an alternative to using setting 5, some customers use setting 1 to create final output for files that contain no spot colors. This rasterizes all the artwork
(i.e., there can be no PostScript errors). However, it is even more important that low-resolution proxy images are replaced with embedded high-resolution
final versions before flattening . You will also be unable to alter the file after it is flattened.

ADOBE APPLICATIONS DIFFER IN THEIR SUPPORT FOR LIVE TRANSPARENCY

Adobe software currently supports transparency at varying levels. Some applications can create, print, and save  (flatten) transparency 
for use in other applications. Some merely accept that flattened information as imported files and pass it along for printing. Others can 
both accept  native  files with live (unflattened) transparent objects and support their manipulation and adjustment within the layout.  

Currently, full support for live transparency exists only in Illustrator 9. Adobe Acrobat 5 also supports live transparency in the form of 
PDF 1.4, but is missing one flattener control—Rasterization Resolution—that Illustrator provides.
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Resolution settings and their interactions
Rasterizing primarily occurs during flattening in two cases: 

• When rasterizing atomic regions. Flattening divides the transparency of a document into a collection of discrete 
areas called atomic regions. Any atomic region that contains an image and/or multiple gradient or mesh objects 
will be rasterized. The flattener usually applies the Mesh Resolution to this area, unless the atomic region has one 
or more images, in which case it applies the maximum of their resolutions, up to the current Rasterization 
Resolution. The flattener also clips the resulting raster with the affected region’s outline, thus preserving all vectors 
in a resolution-independent form. Rasterizing atomic regions can happen at Quality/Speed settings 2 through 5.

• When rasterizing a complexity region. A complexity region is an area in the document that is too complex to 
retain objects in vector form—it has too many objects and would take too long to flatten. Therefore the region 
needs to be rasterized. Rasterizing this area involves rasterizing all the vector objects, images, and text inside the 
area. Scalable vector objects are rasterized at the Rasterization Resolution. It is therefore critical that the Raster-
ization Resolution be set to a value that closely matches the characteristics of the chosen output device. See below, 
“What settings are right?,” for details.

When text in a transparency must be converted to outlines but the font is not available (for example, the font is 
protected), the flattener will treat the text as a regular image and rasterize it using the current Rasterization 
Resolution setting. 

Similarly, any raster-based live effects (which are already rasterized with the Raster Effects Resolution before 
flattening) are treated by the flattener as regular images. 

Table 2: The Quality/Speed Settings for the Flattener

Setting General Effect When to use it Notes

Setting 1
Lowest/Fastest

Rasterizes all artwork according to 
Rasterization Resolution settings. 

To print or export very complex art-
work with many transparent 
objects; for low-resolution proofs of 
complex transparencies.

At higher resolutions, the size of 
saved files or print spool files may 
be large and may take longer to 
print. 

Setting 2
Lower/Faster

Retains simple vector objects, but 
rasterizes more complex areas 
involving transparency.

To print artwork containing only a 
few transparent objects, or when 
you are working on a system with 
low memory.

For Illustrator 9 files, some printing 
devices may produce color stitching 
and make hairlines (lines that are a 
device pixel wide) appear thicker or 
disappear, depending on print 
order. a

a. This problem is corrected in Acrobat 5 and will be corrected in Illustrator 10.

Setting 3
Medium/Medium

Retains most objects as vector data, 
but rasterizes very complex trans-
parent regions.

To achieve a balance between the 
speed of the flattening process and 
the number of regions that are ras-
terized.

This is the default position. It 
reduces color stitching and hairline 
weight issues for some printers.

Setting 4
Higher/Slower

Retains most of the illustration as 
vector data, and rasterizes only 
extremely complex areas. To mini-
mize any color stitching artifacts, 
rasterized areas are clipped to the 
affected objects' paths (unless the 
resulting clip would be too com-
plex).

To achieve a higher quality scalable 
output.

This position reduces color stitching 
and hairline weight issues for some 
printing devices.

Setting 5
Highest/Slowest

Retains vector data to the greatest 
extent possible.

To achieve the highest quality reso-
lution-independent output and 
least image degradation.

This setting the most time- and 
memory-intensive for flattening 
complex illustrations.
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Note that the flattener may also rasterize regions that include objects set to overprint. When this happens, the 
flattener first creates a set of objects that simulate the mixing of inks that would have occurred on press and then 
creates the rasterized region. (For more details on overprinting see “Overprinting may not be preserved:” on page 6 
of this document.)

What settings are right? 

If a file comes in as a native Illustrator 9 file or an Illustrator 9 EPS file, you can change the resolution settings and 
flatten the file to match target press conditions. Any other file format is already flattened in way that locks down the 
resolution for rasterized areas. The important thing to remember is that, whenever possible, you should set the 
resolutions to accommodate your target press conditions before flattening. 

Note: Choosing a higher resolution may increase the size of the resulting flattened file—depending, of course, on how 
much of the artwork is actually rasterized.

Here are some rules of thumb (your workflow requirements may vary):

• The Rasterization Resolution would equal your standard image resolution, such as the customary formula, Line 
Screen x 2. As explained under “A final word about images and transparency” below, you must carefully choose a 
value for this setting to avoid resampling of an image in a transparency. Alternatively, you could use a value equal 
to the full resolution of the intended output device. Bear in mind that this approach may significantly increase the 
size of the flattened document.

• The Raster Effects Resolution would match what is commonly used for drop shadows created in Photoshop (e.g., 
150 dpi). This resolution applies to all raster effects used in Illustrator, including live raster effects and resolution-
dependent filters (e.g., Gaussian Blur). Changing this setting may radically change the appearance of some raster 
effects.

• The Mesh Resolution would equal what you typically use when printing documents that contain meshes and 
gradients to Level 1 or 2 RIPs that do not support the Smooth Shade operator. Location of this setting varies by 
application.  

Keep in mind that the flattener applies the Rasterization Resolution to all rasterized image data it finds in a region—
whether that setting is higher, lower, or equal to the image data’s original resolution. Therefore, images and live raster 
effects may occasionally be inappropriately up- or downsampled for the final output device. This is especially likely 
if the resolution values among the images, flattener, and/or final output device differ significantly. 

You can either make sure the Rasterization Resolution is appropriate for the device before flattening, or make sure 
that image data starts at a resolution that has the least discrepancy with the Rasterization Resolution. For example, 
a 300dpi drop shadow created in Photoshop that gets resampled at 600dpi during flattening will look better than a 
drop shadow that started at 72dpi. A close match among the Raster Effects Resolution, image resolutions, and Raster-
ization Resolutions, all of which should be appropriate to the final output device, is best.  

In general, the higher the Rasterization Resolution setting, the better the results (especially for flattened type). 
However, choosing a very high Rasterization Resolution, such as 2400dpi, will often generate significantly larger 
intermediate files, but may have no visible effect on the quality of the output. Some trial and error may be needed.
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A final word about images and transparency

It is important to understand that rasterizing affects everything in the region that is being rasterized—including 
bitmap (already rasterized) images. If a part of an image is involved in a rasterized region, that part will get resampled 
during flattening, using the Rasterization Resolution (if it falls into the complexity region). At other times it may get 
re-rasterized at a different resolution (if it is part of an atomic region that gets rasterized). When this resolution is 
lower than the image’s resolution, that part of the image will be resampled (usually downsampled) and you will get 
stitching artifacts. To avoid this, be sure to set the Rasterization Resolution to the same resolution as the final version 
of the image, and to replace all proxy images with final images before flattening. (See “Using Image Replacement” in 
Section 2.)

The flattening controls in Adobe products
While all Adobe products apply the same flattener technology, their user interfaces differ in which flattener controls 
they expose and how they are implemented. 

Controls in Adobe Illustrator 9.x

Illustrator 9 has three locations for controlling the settings that affect flattened transparency:

• Quality/Speed slider — File > Document Setup, Transparency panel:

The Transparency panel  in Illustrator’s Document Setup dialog box provides a slider for controlling how much of the art gets rasterized during 
flattening.

• Rasterization Resolution and Mesh Resolution — File > Document Setup, Printing & Export panel: 

A. Use the Printing and Export panel in Illustrator’s Document Setup dialog box.
B. To set the Rasterization Resolution.
C. Mesh Resolution. 

A

B

C
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• Raster Effects Resolution — Effects > Raster Effects > Raster Effects Settings:

The resolution value in Illustrator’s Raster Effects Settings dialog box applies to all rasterized effects in the file. 
In Illustrator 9, the default Raster Effects Resolution value is 72ppi. 

Controls in Adobe Acrobat 5

Acrobat 5 supports the new PDF 1.4 format, which can retain live transparency data when the PDF file is created 
directly from Illustrator 97. The Rasterization Resolution is preset to 300 dpi, which may not be suitable for some 
higher resolution output devices. Acrobat 5 does implement the Quality/Speed setting to provides user control over 
how much of a document is rasterized:

• Quality/Speed menu — Print command, Advanced button, Transparency Quality/Speed popup menu:

You can choose the flattener’s Quality/Speed settings for PDF 1.4 files  in the advanced Print Settings  dialog box in Acrobat 5.

Controls in Adobe Photoshop 5

Photoshop does not have flattening controls, per se. It automatically flattens and rasterizes at the document’s current 
resolution and adds a transparency mask upon export to retain alpha channel information. 

7. Transparency from Photoshop is preserved when saved as PDF 1.4 but as a single alpha channel. 
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